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1 Überblick 

1.1 Was ist CARMA, wer ist Audionet? 
Audionet ist einer der führenden Anbieter von Premiumprodukten der 
Heimunterhaltung – made in Germany. Langjährige Erfahrungen in der 
Entwicklung von „state of the art“-Komponenten und in der Integration 
von hochqualitativen Systemen haben zur Entwicklung von CARMA 
geführt, einem Analyseinstrument für die Raumakustik. Mit dem Com-
puter Aided RooM Analyser lassen sich die akustischen Verhältnisse 
eines Wiedergaberaumes messen und analysieren, sowie ohne größere 
fachliche Vorkenntnisse Korrekturmaßnahmen ermitteln. Insbesondere 
wurde CARMA mit dem Ziel entwickelt, exakte Einstellungen für para-
metrische Equalizer zu bestimmen. Durch den Einsatz parametrischer 
Equalizer lässt sich erfahrungsgemäß der überwiegende Anteil der als 
störend wahrgenommenen Einflüsse der jeweiligen Wiedergabeverhält-
nisse eliminieren. Hierzu gehören vor allem Bassüberhöhungen und 
Dröhneffekte, sowie fehlende Durchhörbarkeit, schlechte Sprachver-
ständlichkeit und mangelnde Raumdarstellung.  
 
Entsprechende Equalizer sind in allen Audionet Heimkinovorstufen in-
tegriert, wie beispielsweise in dem MAP V2 oder dem kleineren Bruder 
MAP I. Führende Fachmagazine sind sich einig: Der MAP V2 ist einer 
der besten Heimkino-Vorverstärker überhaupt und besticht durch seine 
zukunftssichere Konstruktion, die Upgrades und Nachrüstmöglichkeiten 
gewährleistet. Darüber hinaus ist der MAP V2 ein klassischer Stereo-
Vorverstärker, dessen Wiedergabequalitäten auf internationalem Spit-
zenniveau liegen. In Verbindung mit Audionet VIP als hochwertige CD 
und DVD-Quelle und Audionet Leistungsverstärkern wie zum Beispiel 
dem AMP VII können selbst anspruchsvollste Kinos mit einer eindrucks-
vollen und realistischen Klangkulisse ausgestattet werden. 
 
Das Konzept, die Einmess-Software von dem eigentlichen Gerät zu tren-
nen, hat folgenden Grund: Herkömmliche Home Entertainment Systeme 
mit automatischer Einmessung manipulieren selbständig die jeweils er-
mittelten Frequenzgänge. Die Automatik beruht auf einer mehr oder 
minder ausgefeilten Rechenvorschrift, deren Güte und Zuverlässigkeit oft 
zweifelhaft ist. Im Ergebnis entstehen häufig nicht reproduzierbare oder 
sogar falsche Einstellungen. Damit sind diese Systeme von einer klang-
verbessernden Wirkung oft weit entfernt. Außerdem können solche Gerä-
te in keiner Weise die persönlichen Vorlieben des Nutzers berücksichti-
gen. 
CARMA hingegen ermöglicht genaue und zuverlässige Messungen so-
wie eine außerordentlich komfortable und intuitive Simulation von Fil-
tern bzw. Equalizer Einstellungen. Die resultierenden Veränderungen, 
bzw. Korrekturen werden grafisch dargestellt und so unmittelbar nach-
vollziehbar. Hinsichtlich Messgüte und Variabilität erfüllt CARMA hoch 
professionelle Ansprüche. 
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Mit CARMA gibt Ihnen Audionet die Möglichkeit, die Klangverhältnisse 
in Ihrem Hörraum zu überprüfen und zu optimieren. Dabei sind Sie frei, 
Ihre persönlichen Vorstellungen und Vorlieben mit zu berücksichtigen. 
Warum sollte der von Ihnen als angenehm empfundene - wenngleich 
objektiv gemessen leicht überhöhte - Bassbereich durch den Einsatz einer 
„dummen“ Automatik wegfallen? Wir meinen, dass die Entscheidung 
darüber nur Ihnen vorbehalten sein sollte! 
Auch wenn Sie bisher keine Audionet-Komponenten besitzen, können 
Sie von Audionet CARMA profitieren. Sie können unabhängig vom 
verwendeten HiFi- oder Heimkino-System Ihre Raumakustik überprüfen 
und eventuelle Probleme erkennen. Eventuell bietet Ihr System auch eine 
Möglichkeit, den Frequenzgang zu beeinflussen. In diesem Fall können 
Sie mit CARMA Ihr Gerät besser einstellen. 
 
Mehr über Audionet erfahren Sie unter Hwww.audionet.de oder bei: 
 
Idektron GmbH und Co KG, 
Herner Str. 299 
44809 Bochum  
Tel.: 0234 / 50 72 70 
 
Gerne senden wir Ihnen Informationsmaterial, Testberichte und Händler-
nachweise zu. 
 
Viel Spaß mit Audionet CARMA! 
 
Ihr Audionet Team 
 
 

 Hinweis 
Wir haben Audionet CARMA als Freeware auf den Markt gebracht. Die 
Software ist somit im wahrsten Sinne des Wortes ein Geschenk. Wir 
können daher keinen individuellen Support leisten oder irgendeine Ge-
währleistung übernehmen. 
  

http://www.audionet.de
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1.2 Programmeigenschaften 
Raumakustik- und Lautsprecher-Analyseprogramm zur Ermittlung  der 
Impulsantwort und des sich daraus ergebenden Amplitudengangs basie-
rend auf einem logarithmischen Sinussignal als Messstimulus. 
 
Ziel: Auffinden und Korrigieren tonaler, bzw. zeitlicher Raum- und Laut-
sprechereigenheiten. 
 
Audionet CARMA Eigenschaften: 
 
• Intuitive und einfache Bedienbarkeit. 
• Mono-, Stereo-, Mehrkanal- (bis 7.1) und separate Subwoofer-

Messungen. 
• Mittelwertbildung von bis zu 30 Messungen (interne Signalerzeugung) 
• Darstellung des Amplitudengangs des Messobjektes. 
• Darstellung verschiedener minimalphasiger Basis-Equalizer 

(Notch/Peak-Filter, High-/ Low-Shelve sowie Tief-/Hochpass Filter 
erster und zweiter Ordnung). 

• Darstellung des Amplitudengangs der Gesamtanordnung des Messob-
jektes mit Equalizer Filtern als Ergebnis. 

• Darstellung des kumulativen Zerfallsspektrums der Anordnung von 
Lautsprechern und Raum, auch bekannt als Wasserfall-Diagramm. 

• Summendarstellung aller Kanäle im Tieftonbereich. 
• Virtuelles justieren der Subwoofer Entfernung 
• Darstellung der Impulsantwort h(t) im Zeitbereich. 
• Darstellung des logarithmischen Absolutwertes der Impulsantwort h(t). 
• Berechnung der Sprungantwort sigma(t). 
• Darstellung der Energie Zeit Kurve (ETC) und des Schroeder Integ-

rals. 
• Tabellarische Übersichte von akustischen Parameter (EDT, T10, T20, 

T30, TS, C50, C80, D50) 
• Ausschnittsvergrößerung (Zoom) und Skalierung im Zeit- und Fre-

quenzbereich zur genaueren Darstellung der Messergebnisse. 
• 4 Overplots für Kurvenüberlagerungen, zum Vergleich verschiedener 

Messungen 
• Abspeichern und Laden der Messungen, Overplots sowie der Equalizer 

Einstellungen. 
• Export und Ausdruckmöglichkeit der Messdiagramme. 
• Export der Equalizer Einstellungen als Textdatei. 
• Korrekturmöglichkeit für Mikrofonfrequenzgänge. 
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2 Installation / Systemvoraussetzungen 

2.1 Systemvoraussetzungen 
• Java Runtime Environment ab Version SE 5.0 
• PC: Windows 98/2000/2003/XP/Vista mit WDM kompatible full-

duplex Soundkarte. 
• Mac OS X ab Version 10.3.4 
• Messmikrofon 
• Externer Mikrofonvorverstärker (empfohlen) 
 
Audionet CARMA ist ein auf JAVA-Code basierendes Programm wel-
ches zur Funktion "JAVA Runtime Environment" (JRE) benötigt. Ent-
weder ist JRE bereits auf Ihrem PC oder MAC installiert oder muss von 
der Ihnen vorliegenden CD-ROM aus installiert werden. Unter 
Hhttp://www.java.com/de/download können Sie die aktuellste Version 
auch kostenlos herunterladen. 
 
 

 Hinweis 
Der fehlerfreie Betrieb von Audionet CARMA V3.0 kann ab JRE-
Versionen SE 5.0 garantiert werden. 
 

2.2 Installation unter Microsoft Windows 
Im Gegensatz zu den meisten Windowsprogrammen benötigt Audionet 
CARMA keine Installation. Es genügt das Zip-Archive "Audio-
net_CARMA_V3.zip" an den Zielort Ihrer Wahl zu entpacken. Der Pro-
grammstart erfolgt über die Datei "CARMA.exe" die sich im Verzeichnis 
"Audionet CARMA V3.0" befindet. Sollte auf Ihrem Computer keine 
aktuelle Java Version installiert sein, öffnet sich im Standard-Browser 
automatisch die Downloadseite von Java. Folgen Sie für die Java-
Installation den Anweisungen der Internetseite und der Installationsrouti-
ne. Nach der Installation können Sie Audionet CARMA starten. 
 
 

 Hinweis 
Der Programmstart ist wie bei Java Applikationen üblich auch über die 
Datei "CARMA.jar" möglich. Bitte verwenden Sie aber die exe-Datei für 
den Programmstart, da CARMA in diesem Fall mehr RAM-Speicher 
zugeordnet wird und somit fehlerfreie Mehrkanalmessung sichergestellt 
werden kann. 

http://www.java.com/de/download
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2.3 Installation unter Mac OS X 
Bevor Sie Audionet CARMA starten, stellen Sie bitte fest, ob und in 
welcher Version Java bereits installiert ist. Falls die Version älter als die 
benötigte Version SE 5.0 ist, aktualisieren Sie Sie bitte über die AutoUp-
date Funktion oder laden Sie sich die neuste Version von 
Hhttp://www.apple.com/de/support/ herunter und installieren diese. 
  
Entpacken Sie das Zip-Archive "Audionet_CARMA_V3.zip" auf die 
Festplatte. Öffnen Sie das Verzeichnis "Audionet CARMA V3.0" und 
wählen Sie die Datei "CARMA.jar" an. Drücken Sie nun die Tasten "Ap-
fel" und "L" gleichzeitig. Sie haben so eine Verknüpfung (Alias) erzeugt, 
die Sie vorzugsweise auf dem Desktop ablegen. Mit einem Doppelklick 
auf den Alias können Sie Audionet CARMA direkt starten. 

http://www.apple.com/de/support/
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3 Hardware Setup 
Bevor Sie Audionet CARMA starten, sollte zunächst Ihre Soundkarte 
konfiguriert sowie alle Verbindungen zwischen Mikrofon, Computer und 
Audionet MAP V2 (oder andere) hergestellt werden. 

3.1 Einstellen der Soundkarte (Windows) 
Rufen Sie die „Lautstärkeregelung“ (Volume Control) des Betriebsys-
tems auf (Lautsprecher-Icon neben der Windows Uhr oder: Windows 
Startmenü > Zubehör > Unterhaltungsmedien). 
Um den Rauschpegel so gering wie möglich zu halten, stellen Sie den 
Ton sämtlicher Quellen - bis auf "Volume Control" und "Wave" – aus. 

 

 Lautstärkeregelung Windows 

Rufen Sie nun die Aufnahme Lautstärkeregelung auf (Recording Control, 
Optionen > Eigenschaften > Aufnahme > OK). Bestimmen Sie hier den 
Eingang, an dem Sie die Messung durchführen wollen: 

 

Aufnahme Lautstärkeregelung Windows 

Wenn Sie ein Mikrofon direkt an der Soundkarte betreiben wollen, 
schließen Sie es am Mikrofoneingang der Soundkarte an und wählen 
"Microphone".  
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Bei Verwendung eines externen Mikrofonvorverstärkers, schließen Sie 
diesen an den Line-Eingang der Soundkarte an und wählen "Line In". Ihr 
Messsignal kann nun aufgenommen werden, es wird jedoch nicht gleich-
zeitig über die Soundkarte wiedergegeben, sodass Ihre Messungen nicht 
durch Rückkopplungseffekte verfälscht werden.  
 
 

 Hinweis 
Sie können die interne Signalerzeugung von Audionet CARMA nur ver-
wenden, wenn Ihre Soundkarte full-duplex fähig ist (Abspielen und Auf-
nehmen zur gleichen Zeit.) 
 
 
Bei manchen Soundkarten ist die Mixerfunktion (Play Control) etwas 
anders angeordnet. Hier verwendet man bei der Aufnahme Lautstärkereg-
lung einen Kombi Mixer für die Line-Eingänge. Bei Verwendung des 
Line-Einganges muss bei der Wiedergabelautstärkereglung der Line-
Eingang aktiviert bleiben. 

 

Mixerfunktion Windows 

Anschließend muss der Aufnahmemixer aufgerufen und folgende Ein-
stellungen vorgenommen werden. Als Aufnahmequelle wählen Sie bitte 
"Analog Mix".  

 

Aufnahmemixer Windows 
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Anschließend betätigen Sie bitte die "Erweitert"-Taste und stellen "Re-
cord Without Monitoring" ein. 

 

Erweiterte Einstellungen Analog Mix Windows 

Nun ist die Soundkarte so eingestellt, dass bei einer Aufnahme keine 
Rückkopplungseffekte auftreten können. 

3.2 Einstellen der Soundkarte (OS X) 
Rufen Sie Ton in den Systemeinstellungen auf. Klicken Sie auf Eingabe 
und stellen Sie den Eingangspegel des integrierten Mikrofons auf Null. 
Wählen Sie als Quelle den Line-Eingang oder wenn vorhanden den Mik-
rofoneingang, je nachdem ob Sie mit einem externen Mikrofonvorver-
stärker arbeiten wollen oder nicht.  

 

Ton Einstellungen OS X 
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Wählen Sie nun Ausgabe. Stellen Sie die Gesamtlautstärke zunächst so 
ein, dass Sie ¾ des möglichen Ausgangspegels beträgt.  
 

 

Ton Einstellungen Mac OS X 

 

 Hinweis 
Apple Soundkarten unterstützen unter Java nur 44,1kHz. Um eine ein-
wandfreie Funktion von Audionet CARMA sicherzustellen, muss beim 
ersten Start die Abtastrate unter dem Menüpunkt (Options > Preferences) 
von 48kHz auf 44,1kHz umgestellt werden. Bei diesem Betriebsmodus 
werden die Testsignale Track 8 bis Track 14 der Messsignal CD benötigt.  
Falls Sie ein Apple Laptop mit eingebautem Mikrofon verwenden, muss 
der Eingangskanal ebenfalls über diesen Menüpunkt eingestellt werden, 
um ein externes Mirkofon anzusprechen. 

3.3 Anschluss der Geräte 
Die von Ihnen zu verwendende Aufnahmemethode ist von verschiedenen 
Faktoren abhängig:  
 
• Über welche Anschlussmöglichkeiten verfügt Ihr Computer, bzw. des-

sen Soundkarte? 
• Geben Sie die Messsignale über Ihren CD-Player wieder oder nutzen 

Sie die interne Signalerzeugung?  
• Verwenden Sie ein Messmikrofon mit separatem Vorverstärker? 
• Falls Sie ein anderes Gerät als den Audionet MAP V2 verwenden, über 

welche Anschluss- und Ausstattungsmerkmale verfügt dieses? 
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Die Aussagekraft der erzielten Messungen mit Audionet CARMA hängt 
entscheidend von der Qualität des eingesetzten Equipments sowie der 
Sorgfalt bei dessen Einrichtung und Konfiguration ab. Neben einem 
möglichst linearen Frequenzgang sollte das verwendete Mikrofon eine 
omnidirektionale Richtcharakteristik (Kugelcharakteristik) besitzen, um 
bei Mehrkanalmessungen die Surroundkanäle richtig vermessen zu kön-
nen. Von uns empfohlen wird die Verwendung eines Messmikrofons 
(z.B. Behringer ECM 8000) mit Mikrofonvorverstärker (z.B. IMG Stage 
Line MPA-102).  
 
 
a) Anschluss des Mikrofons direkt an den Computer 

 

Verbindung Computer - Mikrofon 

Verbinden Sie das Mikrofon mit dem Mikrofoneingang (Mic in) der 
Soundkarte des Computers.  
 
 

 Hinweis 
Wenn Sie Audionet CARMA auf einem Laptop benutzen, sollten Sie die 
Linearität des Soundkarteneingangs mittels einer Kontrollmessung über-
prüfen um eventuelle Messfehler (vor allem im Tieftonbereich) auszu-
schließen. Weitere Informationen entnehmen Sie bitte Kapitel 8.4 
CARMA auf Laptops. 
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b) Anschluss des Mikrofons über einen Mikrofonvorverstärker an 
den Computer 

 

Verbindung Computer – Mikrofon über Mikrofonverstärker 

1. Verbinden Sie das Mikrofon mit dem Mikrofoneingang (Mic in) 
des Mikrofonvorverstärkers. 

2. Verbinden Sie den Hochpegelausgang des Mikrofonvorverstär-
kers (Line out) mit dem Hochpegeleingang (Line in) der Sound-
karte des Computers. 

3. Stellen Sie den Pegelsteller des Mikrofonvorverstärkers auf mitt-
lere Verstärkung (die Feinjustierung erfolgt später) und stellen 
Sie vorhandene Hochpass- und Tiefpassfilter aus. 

 
 
Verwendung der internen Messsignalerzeugung (Advanced Mode) 
 
Wenn Sie die interne Messsignalerzeugung bevorzugen, müssen Sie zu-
sätzlich den Analog- oder Digitalausgang der Soundkarte mit dem Audi-
onet MAP V2 (oder einem äquivalenten Gerät) verbinden. 
 
 
c) Anschluss des Computers an den Audionet MAP V2 (oder eines 
äquivalente  Gerätes) über eine analoge Verbindung 

 

Analoge Verbindung Computer – Audionet MAP V2  
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1. Verbinden Sie den Hochpegelausgang der Soundkarte des Com-
puters (Line out) mit dem Hochpegeleingang (Line in) des Audi-
onet MAP V2 (oder eines äquivalenten Gerätes). 

 
Bei dieser Anschlussart können Brummschleifen auftauchen, da der 
Computer eine elektrische Verbindung zum angesteuerten Gerät hat. 
Falls Sie diese nicht beseitigen können, verwenden Sie stattdessen die 
externe Signalerzeugung, da das Netzbrummen die Messung verfälscht. 
 
 
d) Anschluss des Computers an den Audionet MAP V2 (oder eines 
äquivalenten Gerätes) über eine digitale Verbindung. 
 

 

Digitale Verbindung Computer – Audionet MAP V2 

1. Verbinden Sie den Digitalausgang der Soundkarte des Computers 
(Digital out) mit dem Digitaleingang (Digital in) des Audionet 
MAP V2 (oder eines äquivalenten Gerätes). 

 
Auch bei dieser Anschlussart können Brummschleifen auftauchen, da der 
Computer eine elektrische Verbindung zum angesteuerten Gerät hat. 
Wenn Ihre Soundkarte über einen optischen Digitalausgang verfügt, ver-
wenden Sie bitte diesen. Falls Sie das Brummen nicht beseitigen können, 
verwenden Sie stattdessen die externe Signalerzeugung, da das Netz-
brummen die Messung verfälscht. 

3.4 Mikrofon Aufstellung 
Um aussagekräftige Messergebnisse zu erhalten ist neben dem verwende-
ten Mikrofontyp auch die richtige Aufstellung des Mikrofons ein ent-
scheidender Faktor.  
 
Abhängig von der Raumgröße bzw. dem Raumvolumen und dem Schall-
entstehungsort breiten sich Schallwellen unterschiedlich aus. Ist die Wel-
lenlänge viel kleiner als die Raumdimension, was bei hohen Frequenzen 
der Fall ist, gilt das Modell der geometrischen Akustik. Dabei wird ange-
nommen dass sich Schallwellen geradlinig im Raum ausbreiten und un-
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abhängig von der Wellenlänge von den Raumbegrenzungen reflektiert 
und gebrochen werden.   
 
Je nachdem wie viel Energie die Schallwellen auf ihrem Weg durch den 
Raum verlieren, besitzen Räume kurze oder längere Nachhallzeiten. 
Wird die Wellenlänge im Verglich zu den Maßen der reflektierenden 
Flächen relativ klein, gilt das Modell der Wellenakustik. Hierbei wird 
mittels der physikalischen Wellentheorie die tatsächliche Schallausbrei-
tung im Raum beschrieben.  
 
Durch Überlagerung können sich Wellen gegenseitig verstärken oder 
auslöschen, wodurch sogenannte Raumeigenmoden entstehen. Dies sind 
dreidimensionale stehende Wellen, die bei bestimmten Frequenzen auf-
treten und zu einer ungleichmäßigen räumlichen Schalldruckverteilung 
führen. Wird eine Eigenmode mit einem Sinussignal angeregt, hört man 
sehr deutlich die schwankenden Pegelunterschiede an den verschiedenen 
Positionen im Raum.  
 
 

 Hinweis 
Da bereits eine Verschiebung der Hörposition von wenigen Dezimetern 
erhebliche Unterschiede im Amplitudengang hervorrufen können, sollte 
das Messmikrofon möglichst an der späteren Hörposition platziert wer-
den. Die Höhe des Mikrofons sollte gleich der Ohrhöhe sein, die der ty-
pischen Haltung beim Musik hören entspricht. 

 

      Perspektive von oben   
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Perspektive von der Seite 

Das Messmikrofon sollte bei Mehrkanalmessungen horizontal in Rich-
tung des Center-Lautsprechers zeigen, bei Stereomessungen in die Mitte 
zwischen den beiden Lautsprechern.  
 
Bei professionellen akustischen Messungen wird gerne auf  einen Kunst-
kopf zurückgegriffen, um die gleichen Voraussetzungen wie bei mensch-
licher Schallwahrnehmung zu erreichen. Der dazu verwendete Kunstkopf 
ist in seinen Abmessungen dem menschlichen Kopf nachgebildet wobei 
die Ohren mit Mikrofonen ausgerüstet sind.  
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4 Schnellstart 
 
Der Start des Programms erfolgt über die Datei CARMA.exe (Windows) 
bzw. durch anklicken der Datei CARMA.jar (OS X). 
Nach dem Start des Programms erscheint zunächst ein kleines Fenster 
mit dem Programmnamen, der Versionsnummer sowie einem Fort-
schrittsbalken für den Ladezustand.  

 

CARMA Startbildschirm 

Kurz darauf erscheint ein größeres Fenster, das CARMA Hauptfenster. 
Das Programm befindet sich im Frequenzbereich.  

 

CARMA Hauptfenster 



 
 
 

 19 
 
 

Nach dem ersten Start befindet sich Audionet CARMA im Stereo Be-
triebsmodus mit externer Messsignalerzeugung. Bei dieser Messmethode 
wird das Messsignal über einen CD- oder DVD-Player abgespielt und die 
Messergebnisse auf dem Computer aufgenommen. Die Messsignale für 
die externe Signalerzeugung können von unserer Internetseite 
www.audionet.de heruntergeladen werden und müssen dann lediglich als 
Audio-CD gebrannt werden. 
 
Verbinden Sie nun Ihr Messmikrofon wie im vorherigen Kapitel be-
schrieben mit Ihrem Computer und nehmen Sie die ebenfalls erläuterten 
Soundkarteneinstellungen vor.  
 
 

 Hinweis 
Wenn Sie Audionet CARMA auf einem Laptop benutzen, sollten Sie die 
Linearität des Soundkarteneingangs mittels einer Kontrollmessung über-
prüfen um eventuelle Messfehler (vor allem im Tieftonbereich) auszu-
schließen. Weitere Informationen entnehmen Sie bitte Kapitel 8.4 
CARMA auf Laptops. 
 
 
Stellen Sie das Mikrofon möglichst an die Position im Raum wo Sie 
beim Musik hören bzw. Filme schauen sitzen. Das Messmikrofon sollte 
in die Mitte zwischen die beiden Lautsprechern zeigen. Die Entfernung 
vom Boden sollte dabei der Ohrhöhe in Ihrer typischen Haltung beim 
Musik hören entsprechen.  
 
 

 Hinweis 
Apple Soundkarten unterstützen unter Java nur 44,1kHz. Um eine ein-
wandfreie Funktion von Audionet CARMA sicherzustellen, muss die 
Abtastrate unter dem Menüpunkt (Options > Preferences) von 48kHz auf 
44,1kHz umgestellt werden. Bei diesem Betriebsmodus werden die Test-
signale Track 8 bis Track 14 der Messsignal CD benötigt.  
Falls Sie ein Apple Laptop mit eingebautem Mikrofon verwenden, muss 
der Eingangskanal ebenfalls über diesen Menüpunkt eingestellt werden, 
um ein externes Mirkofon anzusprechen. 
 
 
Das Drücken des Icons Record mit der linken Maustaste oder die Tasten-
kombination Strg + R bzw. Apfel + R öffnet ein kleines Fenster zur 
Messvorbereitung und Durchführung. 

http://www.audionet.de
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Record-Fenster während der Kalibrierung 

Wenn das Messmikrofon richtig angeschlossen ist, sollte sich jetzt die 
Pegelanzeige im Bereich zwischen -60dB und -40dB bewegen. Falls der 
Ausschlag höhere ist, sollten Sie die Eingangsempfindlichkeit der 
Soundkarte bzw. die Verstärkung des Mikrofonvorverstärkers etwas zu-
rückregeln. Bewegt sich die Pegelanzeige in einem Bereich kleiner als -
60dB überprüfen Sie bitte sämtliche Fehlerquellen wie im Kapitel Tipps 
und Problemlösungen beschrieben. 
 
 
Kalibrierung/Pegeleinstellung 
Vor der Messung muss das Hintergrundgeräusch der Signalkette, des 
Raumes und des Mikrofon-Vorverstärker gemessen werden. Dies passiert 
durch Drücken der Taste Calibrate im Record-Fenster. Es erscheint im 
unteren Teil des Fensters ein Fortschrittsbalken mit der Meldung  
Calibration in Progress. Währenddessen sollte Stille herrschen, da das 
Programm den Geräuschpegel mittelt, speichert und daraus den Trigger-
pegel des Messsignals festlegt. Selbst Störgeräusche aus Nachbarwoh-
nungen oder Straßenlärm können bei der Kalibrierung sowie auch bei der 
Messung zu erheblichen Problemen führen. 
 
 

 Hinweis 
Bei Messungen mit interner Testsignalerzeugung ist keine Kalibrierung 
notwendig. 
 
 
Legen Sie die Audionet CARMA Messsignal CD in Ihren CD oder DVD 
Spieler. Starten Sie die Wiedergabe des 48kHz Stereo Testsignals (Track 
1). Falls Sie mit einem Apple Computer arbeiten benutzen Sie bitte das 
44,1kHz Stereo Testsignal (Track 8). 
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Record-Fenster während der Messung 

Drehen Sie den Lautstärkeregler Ihres Vorverstärkers zur Sicherheit auf 
einen geringen Pegel um eine Zerstörung der Lautsprecher zu vermeiden. 
Steigern Sie allmählich die Lautstärke bis bei der Wiedergabe des Test-
signals die Pegelanzeige mindestens um 30-40dB ansteigt. Dabei darf es 
allerdings nicht zur Übersteuerung (clipping) kommen. Wenn der pas-
sende Pegel eingestellt ist stoppen Sie die Wiedergabe der Messsignal 
CD. 
Bei Messungen mit interner Testsignalerzeugung ist keine Kalibrierung 
notwendig. 
 
 

 Hinweis 
Um reproduzierbare Ergebnisse zu erhalten ist eine hohe Messlautstärke 
erforderlich. Bitte achten Sie unbedingt darauf dass der Pegelunterschied 
zwischen dem Mess-Signal und Stille (Geräuschpegel im Raum) mindes-
tens 30dB-40dB betragen. Wenn sie also einen Rauschpegel von ca. -
45dB während der Kalibrierung (und auch vor Begin des Mess-Signals) 
vorliegt, sollte bei der Wiedergabe des Mess-Sweeps mindestens ein Pe-
gelausschlag von -15dB bis -5dB erreicht werden.  
 
 
Messung 
Durch drücken der Taste Record wird die Messung gestartet. Zuerst er-
scheint ein Countdown von 5 Sekunden um Ihnen die Möglichkeit zu 
geben sich aus dem Messbereich zu entfernen. Danach wir das Messsig-
nal erwartet. Starten Sie nun Track 1 der Messsignal CD (Track 8 bei 
Mac OS). Sobald die Testsignalsequenz erkannt wird erscheint im unte-
ren Teil des Fensters ein Fortschrittsbalken mit der Meldung Recording 
in Progress. Nachdem der linke und rechte Kanal vermessen sind wird 
die Aufnahme automatisch beendet. Anschließend werden die Messer-
gebnisse berechnet und im Hauptfenster angezeigt. 
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Anzeige der Messung 

Durch Aktivieren der Funktion Show EQ erscheint eine horizontale Linie 
mit fünf Punkten, welche den Amplitudengang eines simulierten para-
metrischen Equalizers darstellt. 
Im unteren Teil des Fensters werden die Werte des momentan aktiven 
Teil-Equalizers angezeigt.  
 
Mittels Anwählen eines Teil-Equalizers (Nummerierter Punkt auf der 
Linie) mit der linken Maustaste (z.B. EQ2), kann bei Verschieben mit 
gehaltener Maustaste die Mittenfrequenz und die Verstärkung oder Ab-
schwächung des Filters eingestellt werden. Das Loslassen der Maustaste 
fixiert den EQ-Punkt.  
Die eckigen Klammern stellen die Güte des Teil-Equalizers dar. Ein 
Klick und Halten mit der linken Maustaste auf die Klammern aktiviert 
die Bandbreitenverstellung zu hohen oder niedrigen Bandbreiten (Q-
Wert). Das Loslassen der Maustaste fixiert den eingestellten Wert und 
deaktiviert die Einstellbarkeit. Alternativ können Sie einzelne EQ-Punkte 
über das Auswahlfeld im unteren Fensterbereich anwählen und anschlie-
ßend die Werte für Frequenz, Güte und Verstärkung direkt in die Text-
felder eingeben. Zum Vergleich wird in grün der gemessene Amplitu-
dengang und in gelb der korrigierte Amplitudengang angezeigt. 
 
Durch Anwählen der Funktion (Tools > Equalizer Info) erscheint ein 
Fenster in dem die gesamten EQ-Einstellungen aufgelistet sind. Über die 
Schaltfläche Export as .txt-File können Sie sich die Einstellungen expor-
tieren und bequem auf Ihren MAP V2 übertragen. 
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Equalizer Info Fenster 

Die Messergebnisse sowie alle Einstellungen können selbstverständlich 
geladen, gespeichert, exportiert und ausgedruckt werden. Sobald Sie er-
neut eine Messung durchführen, werden die aktuellen Ergebnisse über-
schrieben. Es wird daher empfohlen alle Messungen grundsätzlich zu 
speichern. Dies geschieht über den Menüpunkt (File > Save), das Disket-
tensymbol oben links im Hauptfenster oder über die Tastenkombination  
Strg + S bzw. Apfel + S. 

 

Speichern eines Messergebnisses 

Audionet CARMA verfügt über eine Vielzahl von Messmethoden und 
Funktionen um Hörräume zu optimieren. Ausführliche Informationen 
entnehmen Sie bitte den folgenden Kapiteln.  
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5 Grundeinstellungen 

5.1 Soundkarte 
 
Soundkarten Ein-/Ausgang 
Standardmäßig werden beim ersten Start von Audionet CARMA die 
Soundkarten Einstellungen ihres Betriebssystems übernommen. Unter 
Windows wird z.B. der sogenannte Primäre Soundtreiber für die Wieder-
gabe und Aufnahme ausgewählt. Bei Apple Betriebssystemen werden 
ebenfalls die Systemeinstellungen übernommen. Verfügt Ihre Soundkarte 
über verschiedene Ein-/Ausgänge können Sie diese über den Dialog 
(Opitons > Preferences) auswählen. 

 

Soundkartenauswahl Windows 

 

 Hinweis 
Gerade unter Windows haben Tests gezeigt dass es mit manchen Sound-
karten zu Schwierigkeiten kommen kann, wenn der Ein-/Ausgang inner-
halb von CARMA ausgewählt wird. Wählen Sie deshalb möglichst den 
Soundkarten Ein-/Ausgang über die Systemsteuerung aus. Sollte Ihr 
Soundkartentreiber die Auswahlmöglichkeit einer festen Abtastrate und 
Bittiefe bieten, stellen Sie diese  auf 48.0 kHz und 16 Bit. Vergewissern 
Sie sich beim Betrieb unter Windows Vista das die Eingestellte Abtastra-
te und Bittiefe in CARMA mit den Einstellungen in der Systemsteuerung 
übereinstimmt. 
 
 

 Hinweis 
Verwenden Sie für die Messung ein Apple Laptop mit eingebautem Mik-
rofon, sollten Sie zusätzlich zu den in Kapitel 3 beschriebenen Soundkar-
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teneinstellungen unter (Opitons > Preferences) den Line-In als Eingang 
auswählen. 
 
 
Sampling Rate 
Moderne Windows Soundkarten arbeiten meist mit einer Abtastrate von 
48kHz, was den Standardeinstellungen von CARMA entspricht. Ältere 
sowie Apple Soundkarten dagegen unterstützen unter Java nur 44,1kHz. 
Um eine einwandfreie Funktion sicherzustellen muss die Abtastrate unter 
dem Menüpunkt (Options > Preferences) von 48kHz auf 44,1kHz umge-
stellt werden. Je nachdem mit welcher Abtastrate gearbeitet wird, werden 
verschiedene Messsignale benötigt. Auf der Messsignal CD finden Sie 
beide Varianten der Signale. 
 
Track 1 – Track 7  : Signale für externe Messungen mit 48,0KHz 
Track 8 – Track 14  : Signale für externe Messungen mit 44,1KHz 
 
 

 Hinweis 
Die Aufnahme der Messung erfolgt in Mono. Dazu wird standardmäßig 
der linke Kanal verwendet. Unter dem Menüpunkt (Tools > Preferences) 
kann wahlweise der linke oder rechte Eingangskanal ausgewählt werden. 

5.2 Betriebsmodus 
Audionet CARMA 3.0 bietet die Möglichkeit, Subwoofer-, Mono-, Ste-
reo- und Merkanal-Messungen (bis 7.1) durchzuführen. Die Auswahl der 
gewünschten Messmethode erfolgt über das Menü (Options > CARMA 
Mode)  bzw. über die Tastenkombination Strg + M bzw. Apfel + M.  

 

Auswahlfenster Messmethode 
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In folgender Tabelle sind die möglichen Messmethoden dargestellt 
 
CARMA MODE BEMERKUNG 
Stereo Signalreihenfolge : L, R 
Left Monomessung des linken Kanals 
Right Monomessung des rechten Kanals 
Sub (PCM) Ausgabe eines ungefilterten Frequenz-Sweeps auf 

dem rechten und linken Kanal 
5.1 (DTS) DTS kodiertes Messsignal für 5.1 Messungen 

Signalreihenfolge : L, C, R, RS, LS, SUB 
7.1 (Dolby PL IIx) Dolby Pro Logic II x  kodiertes Messsignal für 7.1 

Messungen. 
Signalreihenfolge : L, C, R, RS, RB, LB,  LS, 
SUB 

Sub (DTS) DTS kodiertes Messsignal für Subwoofer Mes-
sungen. Die Signalausgabe erfolgt über den LFE-
Kanal 

 
 

 Hinweis 
Bei der Verwendung des 7.1 Modus muss der Dolby Decoder der MAP 
A/V-Vorstufe im Movie-Modus betrieben werden um das Signal korrekt 
auf die hinteren Lautsprecher auszugeben. 
 

5.3 Messsignalerzeugung 
Das Messsignal kann wahlweise extern über einen CD- oder DVD-Player 
mittels der Messsignal CD oder intern (Advanced Mode) über die Sound-
karte ausgegeben werden. Die Auswahl der gewünschten Signalerzeu-
gung erfolgt über das Menü (Options > CARMA Mode)  bzw. über die 
Tastenkombination Strg + M bzw. Apfel + M.  

 

Auswahlfenster Messsignalausgabe 
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Externe Signalerzeugung 
Bei Verwendung der externen Signalerzeugung wird das Messsignal über 
einen CD- oder DVD-Player abgespielt und die Messergebnisse auf dem 
Computer aufgenommen. Die Messsignale für die externe Signalerzeu-
gung können von unserer Internetseite www.audionet.de heruntergeladen 
werden und müssen dann lediglich als Audio-CD gebrannt werden. 
 
Bei diesem Verfahren müssen lediglich das Mikrofon (ggf. Mikrofonvor-
verstärker) mit den Computer verbunden werden. 

 

Verbindung Computer – Mikrofon 

 
Interne Signalerzeugung 
Bei Verwendung der internen Signalerzeugung muss zusätzlich zum 
Mikrofon der Analog- oder Digitalausgang der Soundkarte mit dem Au-
dionet MAP V2 (oder einem äquivalenten Gerät) verbunden werden.         

 

Verbindung Soundkarte – Audionet MAP V2 

Bei Mono- und Stereo-Messungen können Sie wahlweise einen Analog- 
oder Digitalausgang Ihrer Soundkarte benutzen. Mehrkanal- und DTS-
kodierte Subwoofer Messungen müssen dagegen über den Digitalaus-
gang der Soundkarte ausgegeben werden. 
 

http://www.audionet.de
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 Hinweis 
Die Ausgabe von DTS und Dolby Digital Signalen über den Digitalaus-
gang der Soundkarte setzt eine unveränderte Ausgabe des Audiosignal 
voraus. Diese Funktion unterstützen in der Regel nur professionelle Stu-
diosoundkarten oder Soundkarten neuer Generation. Falls Ihre Soundkar-
te bzw. deren Treiber die Lautstärke des Digitalausganges beeinflusst, ist 
eine interne Signalerzeugung bei Mehrkanalmessungen nicht möglich. In 
diesem Fall verwenden Sie bitte die externe Signalerzeugung. 

5.4 Kalibrierung/Pegeleinstellung 
Das Drücken des Icons Record mit der linken Maustaste oder die Tasten-
kombination Strg + R bzw. Apfel + R öffnet ein kleines Fenster zur 
Messvorbereitung und Durchführung. 

 

Record-Fenster während der Kalibrierung 

Wenn das Messmikrofon richtig angeschlossen ist, sollte sich jetzt die 
Pegelanzeige im Bereich zwischen -60dB und -40dB bewegen. Falls ein 
höherer Ausschlag vorhanden ist sollten Sie die Eingangsempfindlichkeit 
der Soundkarte bzw. die Verstärkung des Mikrofonvorverstärkers etwas 
zurückregeln. Bewegt sich die Pegelanzeige in einem Bereich kleiner als 
-60dB überprüfen Sie bitte sämtliche Fehlerquellen wie im Kapitel 
"Tipps und Problemlösungen" beschrieben. 
 
 
Kalibrierung (externe Signalerzeugung) 
Vor der Messung muss das Hintergrundgeräusch der Signalkette, des 
Raumes und des Mikrofon-Vorverstärkers gemessen werden. Dies pas-
siert durch Drücken der Taste Calibrate im Record-Fenster. Im unteren 
Teil des Fensters erscheint ein Fortschrittsbalken mit der Meldung "Ca-
libration in Progress". Währenddessen sollte Stille herrschen, da das 
Programm den Geräuschpegel mittelt, speichert und daraus den Trigger-
pegel des Messsignals festlegt.  
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 Hinweis 
Bei Messungen mit interner Testsignalerzeugung ist keine Kalibrierung 
notwendig. 
 
 
Pegeleinstellung 
Um den Einfluss von Störgeräuschen zu minimieren wird empfohlen das 
Messsignal mit möglichst hoher Lautstärke abzuspielen (>90 dBA). Um 
den optimalen Lautstärkepegel zu finden wird das Messsignal abgespielt 
und die Lautstärke solange erhöht bis bei der Wiedergabe des Testsignals 
die Pegelanzeige mindestens um 30-40dB ansteigt, dabei darf es aller-
dings nicht zur Übersteuerung (clipping) kommen.  

 

Record-Fenster während der Messung 

Drehen Sie zu Beginn den Lautstärkeregler Ihres Vorverstärkers zur Si-
cherheit auf einen geringen Pegel um eine Zerstörung der Lautsprecher 
zu vermeiden. Die Wiedergabe es Testsignals erfolgt bei externer Mes-
sung mittels der Messsignal CD. Bei interner Signalerzeugung können 
Sie mit der Schaltfläche Stimulus (on/off) die Wiedergabe des Testsig-
nals starten und stoppen.  
 
 

 Hinweis 
Um reproduzierbare Ergebnisse zu erhalten ist eine hohe Messlautstärke 
erforderlich. Bitte achten Sie unbedingt darauf dass der Pegelunterschied 
zwischen dem Mess-Signal und Stille (Geräuschpegel im Raum) mindes-
tens 30dB-40dB betragen. Wenn sie also einen Rauschpegel von ca. -
45dB während der Kalibrierung (und auch vor Begin des Mess-Signals) 
vorliegt, sollte bei der Wiedergabe des Mess-Sweeps mindestens ein Pe-
gelausschlag von -15dB bis -5dB erreicht werden.  

5.5 Mittelwertbildung (Advanced Mode) 
Neben hoher Messlautstärke kann ebenfalls durch Mittelwertbildung der 
Einfluss von Störgeräuschen minimiert werden. Im Aufnahmefenster 
können müssen Sie über Averaging auswählen, aus wie vielen Messun-
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gen Ihr Messergebnis gemittelt werden soll. Drücken Sie ▲ oder ▼ um 
die Anzahl der Messungen einzustellen.  

 

Aufnahmefenster 

Den Standardwert für die Anzahl der Mittelwertbildungen können Sie 
über den Menüpunkt (Options > Preferences) festlegen (einstellbar von 
1-30 Messungen, voreingestellt sind 3 Messungen). 

5.6 Programmeinstellungen 
Über den Menüpunkt Options öffnen Sie das Fenster Preferences. Über 
dieses Fenster können neben den in Kapitel 5.1 beschriebenen Soundkar-
ten Einstellungen weitere Grundeinstellungen von Audionet CARMA 
vorgenommen werden. 

 

Fenster für Einstellungen  

Measurement 
Recording countdown 
(seconds) 

Dauer bis zum eigentlichen Messbeginn 
nach Betätigung der Record-Taste.  

Samples before detected  
IR start 

Dieser Wert legt den Startpunkt der Im-
pulsantwort fest.  

Default Averaging 
(internal meas.) 

Anzahl der Mittelwertbildungen bei 
Messungen mit interner Signalerzeugung 

Open last Mic Correction on 
startup 

Ist diese Funktion aktiviert, wird beim 
Programmstart die letzte verwendete 
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Mikrofonkorrektur geladen. 
Export  (Einstellungen für den Export von Amplitude und Phase im 
ASCII-Textformat) 
Frequency Range (Hz) Frequenzbereich der für den Export. 
Number of data points Anzahl der Datenpunkte. 
0 dBr equals a SPL of (dB) Der Referenzpegel von 0dBr im Fre-

quenzbereich entspricht einem Schallpe-
gel von x (dB). 

Directories 
Measurement Directory Standardverzeichnis zum Öffnen und 

Speicherung von "Audionet Measure-
ment Files (*.amf)". 

Data Directory Standardverzeichnis zur Speicherung 
von "Audionet Equalizer Files (*.aef)", 
"Audionet Overplot Files (*.aef)" sowie 
sämtlichen Export/Import Dateien. 
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6 Grafische Darstellung 

6.1 Bedienungshinweise 
Um einen möglichst einfache und benutzerfreundliche Bedienung zu 
erreichen, sind die wichtigsten Funktionen in der Symbolleiste im Haupt-
fenster angeordnet. 

 

Symbolleiste des Hauptfensters 

a) Anzeigemodus 
Über diese Schaltfläche können Sie zwischen den einzelnen Anzeigemo-
di wechseln. Neben Amplitudengang, Zeitbereich und Wasserfalldia-
gramm besteht bei Mehrkanalmessungen die Möglichkeit mittels des 
"Operational Windows“ eine Summendarstellung aller Kanäle im Tief-
tonbereich anzeigen zu lassen. 
 
 
b) Kanalauswahl 
Auswahl bzw. Information über den aktuell dargestellten Kanal 
 
 
c) Einstellungen 
Diese Schaltfläche öffnet ein Fenster über das weitere Einstellungen für 
den aktuellen Anzeigemodus vorgenommen werden können z.B. FFT-
Größe, Fensterfunktion usw. 
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d) Zoommodus 
Ein Ausschnitt des Bildbereichs kann vergrößert dargestellt werden, in-
dem das Symbol der Lupe angewählt wird oder mit der rechten Maustas-
te Zoom aktiviert wird. Tun Sie dies, verwandelt sich der Mauszeiger in 
eine Lupe. Damit können Sie einen Eckpunkt des Zoom-Bereichs mit der 
linken Maustaste anklicken und bei gedrückter Taste den zweiten Eck-
punkt festlegen. Nach loslassen der Maustaste wird der ausgewählte Be-
reich vergrößert dargestellt. Der Zoommodus kann durch drücken der 
ESC-Taste wieder verlassen werden.  
 
 
e) Gesamtansicht 
Beim anklicken dieser Schaltfläche werden die Zoom-Einstellungen zu-
rückgesetzt und die Gesamtansicht der ausgewählten Darstellung ange-
zeigt. 
 
 
f) Horizontaler/Vertikaler Zoom 
Mit Hilfe der + und - Zeichen im unteren Fensterbereich kann das Bild in 
horizontaler und vertikaler Richtung vergrößert und verkleinert werden. 
Wird die Schaltfläche zwischen den Zeichen angeklickt, kann bei gehal-
tener Maustaste das Zoomen schneller erfolgen. Über die grauen Balken, 
die sich beim Vergrößern bilden, kann das Diagramm auch in horizonta-
ler und vertikaler Richtung verschoben werden. 
 
 
g) Koordinatenanzeige 
Abhängig vom Anzeigemodus werden in diesem Bereich die jeweiligen 
Werte der x- und y-Achse mit der entsprechenden Einheit dargestellt. 
 
 

 Hinweis 
Wurde die Darstellung durch zoomen vergrößert, kann durch halten der 
linken Maustaste die aktuelle Ansicht mittels Maus verschoben werden. 
 

6.2 Frequenzbereich 
Laden Sie zum Beispiel die Audionet-Messdatei example_7_1.amf. Es 
erscheint der Amplitudengang der Messung. Die Darstellung zeigt den 
logarithmischen Betrag des Frequenzgangs in Dezibel (dBr), über der 
Frequenz ebenfalls logarithmisch dargestellt. Dies ist eine standardisierte 
und übliche Darstellung. Dabei werden die Messung durch eine grüne 
Linie und der per Equalizer korrigierte Verlauf mit einer gelben Linie 
dargestellt. 
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Darstellung des Frequenzgangs 

 

Einstellungen für den Frequenzbereich 
Über die Schaltfläche Einstellungen (Kap. 6.1 c) können Sie die Einstel-
lungen für den aktuellen Anzeigemodus ändern. 

 

Fenster Einstellungen 

FFT Size Anzahl der Datenpunkte (Blockgröße) der Fast 
Fourier Transformation (2048…65536 Punkte). 

Window Function Fensterfunktionen: Blackman-Harris, Hanning-, 
Hamming-, Blackman- und Rechteck-Fenster. 

Octave-Band 
Smoothing 

Glättung des Kurvenverlaufs über 1/n-Oktaven. 
(n=1,2.3,6,12,24). 

Display Settings Ein-/Ausblendmöglichkeit von original und kor-
rigierter Messkurve. 
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Plot Type Wahlweise kann zwischen Amplitudengang & 
Equalizer und der Anzeige von Amplituden- & 
Phasengang ausgewählt werden. Im zweiten Fall 
wird die akustische Phase von -180° bis +180° 
angezeigt. Dabei kann die gemessenen, die be-
rechneten minimal oder die "excess" Phase an-
gezeigt werden.  

6.3 Zeitbereich 
Der Zeitbereich wird durch Anwahl des Icons Time dargestellt. Es er-
scheint die zeitdiskret abgetastete Impulsantwort h(t) des Messobjekts 
aufgetragen über der Zeit t in tausendstel Sekunden (ms). Die Impuls-
antwort wird automatisch in der Größe skaliert (vertikal) und hat eine 
maximale Länge von 65536 Abtastpunkten. Das entspricht bei einer Ab-
tastfrequenz von 44,1kHz einer Zeitdauer von 1486 ms (1.486 Sek.). 

 

Fenster Zeitbereich 

Durch Verschieben der rechten roten Vertikalbegrenzung mit der Maus 
nach links wird der effektive Zeitausschnitt verringert, und es fallen nur 
noch frühe Schallanteile mit in die Signalverarbeitung. Diesen Vorgang 
nennt man Fenstern, da die Länge der Gewichtungsfunktion im Zeitbe-
reich (gelbe Kurve) einen Ausschnitt der Messung wählt (ein Zeitfens-
ter). Über die rechte Maustaste lassen sich komfortabel Start- und End-
punkt oder auch das Zeitfenster abhängig von der FFT-Größe festlegen. 
 
Durch einen Doppelklick in den rechten bzw. linken Anzeigebereich 
wird die Ansicht um den Faktor 2 verkleinert bzw. vergrößert. 
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 Hinweis 
Wird die Anzahl der Punkte im Zeitfenster kleiner als die FFT-Größe 
gewählt erfolgt ein Zero Padding der restlichen Werte d.h. alle Werte 
außerhalb des Zeitfensters werden mit Nullen "aufgefüllt". 
 
Die Fensterfunktion kann nach belieben den Erfordernissen angepasst 
werden (rechte Maustaste > Window Function > … oder über die Schalt-
fläche Einstellungen) und beeinflusst natürlich die Darstellung des Amp-
litudengangs im Frequenzbereich. 
 
Im unteren Fensterbereich befindet sich ein kleines Auswahlfenster mit 
dem sich verschiedene Darstellungen des Zeitbereichs auswählen lassen. 
 
Impulse  Response 
(lin) 

Impulsantwort h(t) als grundlegende Darstellung 

Impulse  Response 
(log) 

Logarithmische Funktion des Absolutwertes der 
Impulsantwort (zeigt das Abklingen des Schallan-
teils im Raum und die Höhe der Störgeräusche) 

Step Response Sprungantwort sigma(t) als Antwort auf einen 
Signalsprung 

Energy Time Cur-
ve 

Die Energie-Zeit-Kurve zeigt Pegelabfall der 
Raumantwort über die Zeit. Das Schroeder-
Integral ergibt sich aus der rückwärts Integration 
der quadrierten Impulsantwort und gibt die soge-
nannte Energy-Decay-Kurve 

 
Einstellungen Zeitbereich 
Über die Schaltfläche Einstellungen (Kap. 6.1 c) können Sie die Einstel-
lungen für den aktuellen Anzeigemodus ändern. 

 

Fenster Einstellungen 

FFT Size Anzahl der Datenpunkte (Blockgröße) der Fast 
Fourier Transformation (2048…65536 Punkte). 

Window Function Fensterfunktionen: Blackman-Harris, Hanning-, 
Hamming-, Blackman- und Rechteck-Fenster. 
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6.4 Wasserfalldiagramm 
Das Wasserfalldiagramm (cumulative spectral decay) beschreibt das 
Zerfallen oder auch das Ausklingen der Schallanteile (Spektrum) über 
der Frequenz und der Zeit. Somit ist eine Analyse der Eigenheiten von 
Lautsprecher und Messraum durch die dreidimensionale Darstellung 
möglich. Es können sowohl Resonanzen, Absorptionen und Überhöhun-
gen festgestellt werden oder auch Echos des zu messenden Raumes.  

 

Wasserfalldiagramm 

Einstellungen Wasserfalldiagramm 
Über die Schaltfläche Einstellungen (Kap. 6.1 c) können Sie die Einstel-
lungen für den aktuellen Anzeigemodus ändern. 

 

Fenster Einstellungen 
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FFT Size Anzahl der Datenpunkte (Blockgröße) der Fast 
Fourier Transformation (128…8192 Punkte). 

Window Function Fensterfunktionen: Blackman-Harris, Hanning-, 
Hamming-, Blackman- und Rechteck-Fenster. 

Octave-Band 
Smoothing 

Glättung des Kurvenverlaufs über 1/n-Oktaven. 
(n=1,2.3,6,12,24). 

Max. time (ms)  
Min. time (ms) 

Standardmäßig ist der Analysebereich mit dem 
ausgewählten Zeitfenster der Impulsantwort ver-
knüpft. Ist die Option Use time markers to set ran-
ge deaktiviert, können unabhängig vom ausgewähl-
ten Zeitfenster der zeitliche Anfangs- und End-
punkt für die Analyse angegeben werden. 

Rise time (ms) Zeitintervall am Anfang und Ende des Zeitfensters 
bei dem die Fensterfunktion angewandt wird. 

Slices Anzahl der abzubildenden Ausschnittsspektren im 
eingestellten Zeitbereich (y-Achse). 

Auto Update Plot Um Verzögerungen bei der Darstellung, besonders 
bei älteren Computern zu vermeiden, besteht die 
Möglichkeit die Berechung des Wasserfalldia-
gramms nur durch klicken der Schaltfläche Calcu-
late berechnen zu lassen. Deaktivieren Sie dafür 
die Funktion Auto Update Plot 

Apply Eq-Settings Die vorgenommenen Equalizer Einstellungen wer-
den bei der Berechnung des Gesamtbildes berück-
sichtigt. Diese Funktion kann an dieser Stelle akti-
viert und deaktiviert werden. 

Use time markers 
to set range 

Ist diese Option deaktiviert, können unabhängig 
vom ausgewählten Zeitfenster der zeitliche An-
fangs- und Endpunkt für die Analyse angegeben 
werden. Ansonsten ist der Analysebereich über das 
Zeitfenster der Impulsantwort festgelegt. 

 

 Hinweis 
Im Gegensatz zu vorherigen CARMA Versionen wird die Darstellung in 
vertikaler und horizontaler Richtung (Amplitude und Frequenz) mit Hilfe 
der + und - Zeichen im unteren Fensterbereich vergrößert und verklei-
nert. Desweiteren ist das Wasserfalldiagramm direkt mit einer Messung 
verknüpft und lässt sich nicht mehr separat speichern. 
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6.5 OpWin (Operational Window) 
Durch die Anwahl des Icons OpWin öffnet sich ein weiteres Programm-
fenster. Bei dieser Darstellung können die einzelnen Kanäle einer Mes-
sung im Tieftonbereich summiert werden. Unter Berücksichtigung der 
Phase werden die mittels Auswahlschaltflächen selektierten Kanäle ad-
diert und der Summenverlauf (gelb) angezeigt.  
 
Innerhalb dieses Programmfensters können Sie über die Funktion SUB 
Adjustment die Laufzeit des Subwoofer-Kanals virtuell verschieben um 
eine optimale Schalladdition im Tieftonbereich zu erhalten.  
 
 

 Hinweis 
Bei dem eingestellten Wert des Feldes SUB Adjustment handelt es sich 
um relative Werte, die Sie mit dem bei der Messung eingestellten Wert 
der Subwoofer-Entfernung ihres MAP A/V-Vorverstärkers  verrechnen 
müssen. Haben Sie z.B. eine Entfernung von 350cm bei Ihrem MAP ein-
gestellt und die Funktion SUB Adjustment liefert eine optimale Schall-
addition bei einem Wert von -70cm, ergibt sich eine neue Entfernung von 
280cm die Sie bei Ihrem MAP einstellen müssen. 
 

 

Operational Window 
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Einstellungen OpWin 
Über die Schaltfläche Einstellungen (Kap. 6.1 c) können Sie die Einstel-
lungen für den aktuellen Anzeigemodus ändern. 

 

Fenster Einstellungen 

FFT Size Anzahl der Datenpunkte (Blockgröße) der Fast 
Fourier Transformation (2048…65536 Punkte). 

Window Funktion Fensterfunktionen: Blackman-Harris, Hanning-, 
Hamming-, Blackman- und Rechteck-Fenster. 

Octave-Band 
Smoothing 

Glättung des Kurvenverlaufs über 1/n-Oktaven. 
(n=1,2.3,6,12,24). 

Apply Eq-Settings Die vorgenommenen Equalizer Einstellungen 
werden bei der Berechnung des Gesamtbildes 
berücksichtigt. Diese Funktion kann an dieser 
Stelle aktiviert und deaktiviert werden. 

 
 

 Hinweis 
Diese Darstellungsform steht nur bei Mehrkanalmessungen zur Verfü-
gung. 
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7 Tools 

7.1 Equalizer 
Durch Aktivieren der Funktion Show EQ erscheint eine horizontale Linie 
mit fünf Punkten, welche den Amplitudengang eines simulierten para-
metrischen Equalizers darstellt. Im unteren Teil des Fensters werden die 
Werte des momentan aktiven Teil-Equalizers angezeigt.  

 

Darstellung Amplitudengang 

Durch Anwählen der Funktion Tools > Equalizer Info erscheint ein Da-
tenfeld des aktiven Kanals mit dessen gesamten EQ-Einstellungen. 
 
Mittels Anwählen eines Teil-Equalizers (Nummerierter Punkt auf der 
Linie) mit der linken Maustaste (z.B. EQ1), kann bei Verschieben mit 
gehaltener Maustaste die Mittenfrequenz und die Verstärkung oder Ab-
schwächung des Filters eingestellt werden. Loslassen der Maustaste fi-
xiert den EQ-Punkt. Die eckigen Klammern stellen die Güte des Teil-
Equalizers dar. Ein Klick und das Halten mit der linken Maustaste auf die 
Klammern aktiviert die Bandbreitenverstellung zu hohen oder niedrigen 
Bandbreiten (Q-Wert). Das Loslassen der Maustaste fixiert den einge-
stellten Wert und deaktiviert die Einstellbarkeit. Alternativ können Sie 
einzelne EQ-Punkte über das Auswahlfeld im unteren Fensterbereich 
anwählen und anschließend die Werte für Frequenz, Güte und Verstär-
kung direkt in die Textfelder eingeben. Zum Vergleich wird in grün der 
gemessene Amplitudengang und in gelb der korrigierte Amplitudengang 
angezeigt. 
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Über das Drücken der rechten Maustaste können der aktive oder alle 
Teil-Equalizer zurückgesetzt werden (Reset Selected EQ-Band und Re-
set All EQ-Bands). Möchten Sie die Einstellungen aller Teil-Equalizer 
auf einen anderen Kanal übertragen, kann dies über die Funktionen Copy 
Eq-Channel und Paste Eq-Channel geschehen die ebenfall über die 
rechte Maustaste erreichbar sind. Mit Hilfe der Funktion Type lassen sich 
weitere EQ-Filterarten wählen. Es ist damit möglich verschiedene mini-
malphasige Basis-Equalizer darzustellen. Diese sind Notch/Peak-Filter, 
High-/Low-Shelve, Hoch-/Tiefpass (erster Ordnung) und Hoch-/Tiefpass 
(zweiter Ordnung) 
 
 

 Hinweis 
Sowohl der Audionet MAP I wie auch der große Bruder MAP V2 unter-
stützen zum jetzigen Zeitpunkt nur parametrische Notch-/Peak-Filter. Die 
Minimal- und Maximalwerte sowie die Schrittweite für Frequenz (fre-
quency), Verstärkung (gain) und Güte(q) wurde beim Entwurf von 
CARMA von den Geräten übernommen. Dadurch wird es möglich die 
eingestellten Werte exakt auf Ihren MAP zu übertragen. 
 
 
Die vorgenommenen Equalizer Einstellungen sind automatisch mit den 
Messungen verknüpft. Möchten Sie die EQ Einstellungen einer Messung 
auf eine andere übertragen, können Sie diese als Audionet EQ-File 
(*.aef) über File > Export > Eq-Settings exportieren und sie später in 
eine andere Messung importieren (File > Import > Eq-Settings).  

7.2 Equalizer Info 
Sie können die mit CARMA gefundenen Equalizerwerte in Ihre Audionet 
MAP A/V-Vorstufe einprogrammieren. Der Menüpunkt Tools > Equali-
zer Info öffnet ein Fenster in dem die eingestellten Filter jedes Kanals in 
Listenform angezeigt werden. 

 

Equalizer Info Fenster 
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Rufen Sie nach und nach alle Kanäle auf und programmieren Sie mit den 
CARMA-Equalizer-Werten Ihren MAP. Alternativ können Sie die Ein-
stellungen über die Schaltfläche Export as Txt-File exportieren und be-
quem auf Ihren MAP übertragen. 
 
 

 Hinweis 
Sowohl der Audionet MAP I wie auch der große Bruder MAP V2 unter-
stützen zum jetzigen Zeitpunkt nur parametrische Notch-/Peak-Filter. Die 
Minimal- und Maximalwerte sowie die Schrittweite für Frequenz (fre-
quency), Verstärkung (gain) und Güte(q) wurde beim Entwurf von 
CARMA von den Geräten übernommen. Dadurch wird es möglich die 
eingestellten Werte exakt auf Ihren MAP zu übertragen. 

7.3 Akustische Parameter 
Über die gemessene Impulsantwort lassen sich so genannte akustische 
Parameter berechnen. Diese helfen die akustischen Eigenschaften eines 
Raumes zu beurteilen. Über vorher/nachher Messungen können Sie die 
Auswirkung von baulichen Maßnahmen analysieren oder z.B. verschie-
dene Räume miteinander vergleichen. Die Parameter werden über den 
Menüpunkt Tools > Acoustical Parameters in einem neuen Fenster in 
Listenform dargestellt. Die einzelnen Parameterwerte werden in Oktav-
Schritten von 31,5 Hz bis 16kHz angezeigt. 

 

Darstellung akustische Parameter 

EDT [s] Die "Early Decay Time" oder frühe Abklingzeit, gibt 
an in welcher Zeit der Schalldruckpegel des Aus-
gangssignals um 10 dB abnimmt 

T10 [s],  
T20 [s], 
T30 [s] 

Nachhallzeit, die sich aus dem Abfall des Schallpegels 
von –5 dB unterhalb des anfänglichen Maximums um 
x dB ergibt (-5 bis –5+x dB). Im Fall von T30 der Ab-
fall des Schallpegels von (-5 bis -35 dB) 
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TS[ms] "Center Time" oder Schwerpunktzeit ist ein Kriterium 
für die Sprachverständlichkeit. Sie beschreibt den 
Zeitraum des Energiemaximums.  

C50 [dB] Das Deutlichkeitsmaß ist Kriterium für die zeitliche 
Struktur von Schallfeldern im Bezug auf Sprache. Ein 
größerer Wert bedeutet eine bessere Sprachverständ-
lichkeit im Raum. Es berechnet sich über das Verhält-
nis der Schallenergie der ersten 50 ms zur nach dem 
Zeitpunkt 50 ms eintreffenden Schallenergie.  

C80 [dB] Das Klarheitsmaß ist Kriterium für die zeitliche Struk-
tur von Schallfeldern im Bezug auf Musik. Es kenn-
zeichnet die Durchsichtigkeit, d. h. die Erkennbarkeit 
einzelner aufeinander folgender Töne. Es ergibt sich 
aus dem Verhältnis der Schallenergie der ersten 80 ms 
zur gesamten nach dem Zeitpunkt 80 ms eintreffenden 
Schallenergie.   

D50 [%] Das Deutlichkeitsmaß ist Kriterium für die zeitliche 
Struktur von Schallfeldern im Bezug auf verschiedene 
Darbietungsformen. Es ergibt sich aus dem Verhältnis 
der Schallenergie bis 50 ms zur gesamten eintreffen-
den Schallenergie.   

7.4 Mikrofon Korrektur 
Der Umstand, dass die meisten Mikrofone/Messmikrofone einen meist 
nicht ganz linearen Amplitudengang aufweisen, hat direkten Einfluss auf 
das Messergebnis. Zu diesem Zweck verfügt Audionet CARMA über 
eine Mikrofon Korrektur, mit der sich ein aus der Mikrofonfrequenzcha-
rakteristik ergebene Messfehler nachträglich entfernen lässt. Hierfür 
können vorgefertigte Mikrofonkennlinien verwendet oder eigene Korrek-
turkennlinien angefertigt werden. 
 
Durch Aktivieren der Funktion Show Mic erscheint eine horizontale Li-
nie, welche den Amplitudengang einer Mikrofon Korrektur darstellt. 
Öffnen Sie nun das Menü Mikrofon Korrektur (Tools > Microphone 
Correction). Laden Sie eine Mikrofon Frequenzkennlinie (File > Load). 
Es erscheint ein neues Fenster, indem Sie die Datei auswählen können, 
zum Beispiel die Korrekturkennlinie "Behringer_ECM8000.amt".  
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Fenster für Mikrofon Korrektur 

Drücken Sie Apply um die Mikrofon Frequenzkorrektur auf Ihr Messer-
gebnis anzuwenden. 
 

 

Amplitudengang einer Mikrofon Korrektur 

 
Über Remove können Sie die Mikrofon Frequenzkorrektur wieder rück-
gängig machen. Sie können auch eine eigene Mikrofon Frequenzkennli-
nie erstellen, indem Sie im Menü Mikrofon Korrektur Pegel (dB) die 
verschiedenen Frequenzen nach Ihren Wünschen anpassen (Doppelklick 
auf den Pegelwert > neuen Pegel eingeben > mit "Enter" bestätigen). 
Über Apply bzw. Remove können Sie Ihre Frequenzkennlinie hinzufügen 
oder entfernen und nach deren Fertigstellung abspeichern (File > Save). 
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 Hinweis 
Standardmäßig wird beim Programmstart die letzte verwendete Mikrofon 
Frequenzkorrektur geladen. Über das Menü Options > Preferences kön-
nen Sie diese Funktion aktivieren und deaktivieren. 

7.5 Overplot 
Die Overplot Funktion ermöglicht es Ihnen, mehrere Messkurven gleich-
zeitig darzustellen. Somit können verschiedene Messungen miteinander 
verglichen werden. Es können maximal vier Frequenzkennlinien über-
einander gelegt und zusammen betrachtet werden. Die Overplot Funktion 
speichert die Kennlinie des angewählten Kanals inklusive der vorge-
nommenen Equalizer Einstellungen. 

 

Overplot Darstellung der Frequenzkennlinien 

Wählen Sie den Kanal aus, dessen Kennlinie Sie zum Vergleich heran-
ziehen wollen. Drücken Sie auf eine der vier Set-Tasten im unteren Teil 
des Fensters. Die Kennlinie ist nun gespeichert und wird in einer anderen 
Farbe angezeigt. Zuvor gespeicherte Werte werden dabei gelöscht. Wäh-
len Sie nun einen anderen Kanal aus (Sie können auch eine neue Mes-
sung durchführen oder eine frühere Messung laden) mit der Sie die Kur-
ve vergleichen wollen. Über die Kontrollkästchen neben den Overplot-
Schriftzügen lässt sich die Vergleichskennlinie ein- und ausblenden. 
Über die Schaltfläche Reset All Overplots werden alle vier Kurven ge-
löscht und ihre Grundeinstellungen wieder hergestellt. 
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Overplot Einstellungen 
Die Schaltfläche Edit öffnet ein Popup-Fenster über das sich die vier 
Overplots jeweils konfigurieren lassen. Neben der Änderung der Farbe 
und Bezeichnung können Kommentare eingefügt und ein Offset addiert 
werden. 

 

Overplot Einstellungen 

7.6 Processing 
In der Regel ist es nicht notwendig Manipulationen an der gemessenen 
Impulsantwort vorzunehmen. In manchen Fällen ist es trotzdem nötig 
nachträglich die gemessene Impulsantwort zu bearbeiten. Wird z.B. 
durch Störgeräusche oder eine minderwertige Soundkarte der Beginn der 
Impulsantwort nicht richtig erkannt, kann dieser Fehler über Processing 
> Move Impulse Response nachträglich manuell behoben werden (siehe 
Kapitel "Tipps & Problemlösungen").  
In der folgenden Tabelle ist eine übersicht sämtlicher Funktionen zu fin-
den.  
 
Funktion Bemerkung 
Invert Die Phase der Messung wird um 180° gedreht.  
Reverse Führt zur zeitlichen Umkehr der Impulsantwort. 
Move Diese Funktion dient zur Verschiebung der gemessenen 

Impulsantwort. 
Amplify Verstärkung um einen konstanten Faktor.  
Filter Anwendung von Butterworth Hoch-/Tief-/Bandpass 

Filtern. 
 
Da sich die Bearbeitung direkt auf die Impulsantwort auswirkt, ist der 
Menüpunkt Processing nur im Zeitbereich aktiviert.   
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 Hinweis 
Die Bearbeitung der Impulsantwort erfolgt destruktiv, d.h. vorgenomme-
ne Änderungen werden direkt an den Messdaten durchgeführt. Über die 
Funktion "Undo" ist es lediglich möglich einen Bearbeitungsschritt zu-
rück zu gehen. Speichern Sie aus diesem Grund immer zuerst die Mes-
sung um auch zu einem späteren Zeitpunkt auf die Originaldaten zurück-
greifen zu können. 

7.7 Datei Informationen 
Über den Menüpunkt  File > File Info wird ein Programmfenster geöff-
net in dem sämtliche relevanten Informationen über die geladene bzw. 
durchgeführte Messung zu finden sind. Es werden Datum, Betriebsmo-
dus, Signalerzeugung und Abtastfrequenz angezeigt. Desweiteren besteht 
die Möglichkeit ausführliche Kommentare über z.B. die Mikrophonposi-
tion oder den Messaufbau zu hinterlegen. 

 

Informationsfenster der Messung 
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8 Tipps und Problemlösungen 

8.1 Menü-Referenz 
 
File  

New Initialisierung einer neuen Messung 

Open Zeigt ein Dialogfeld zum Öffnen 
einer neuen Messung. Als Dateityp 
werden "Audionet Measurement 
Files (*.amf)" erwartet. 

Open Recent Zeigt eine Liste mit den zuletzt 
benutzten Dateien. Durch die Aus-
wahl einer Datei wird diese erneut 
geöffnet. 

Save Speichert eine geöffnete Messung 
unter gleichem Namen als "Audio-
net Measurement Files (*.amf)".  

Save As Zeigt ein Dialog zum Speichern der 
aktuellen Messung als "Audionet 
Measurement Files (*.amf)". 

Import Eq-Settings Öffnet ein Dialogfeld zum Import 
von Equalizer Einstellungen. Als 
Dateityp werden "Audionet Equali-
zer Files (*.aef)" erwartet.  

Import Overplots Öffnet ein Dialogfeld zum Import 
von Overplot Dateien. Als Dateityp 
werden "Audionet Overplot Files 
(*.ovp)" erwartet. 

Export Eq-Settings Zeigt ein Dialog zum Export von 
Equalizer Einstellungen. Es wird 
eine "Audionet Equalizer Files 
(*.aef)" erstellt. 

Export Eq-Settings as .txt-File Zeigt ein Dialog zum Export von 
Equalizer Einstellungen. Die Daten 
werden als Textdatei (*.txt) gespei-
chert.  

Export Overplots Öffnet ein Dialogfeld  zum Export 
der Overplot Einstellungen.  

Export Plot as Jpeg Öffnet ein Dialogfeld  zum Export 
der aktuellen Ansicht als JPEG-
Grafikdatei. 
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Export Amplitude as .txt-File Öffnet ein Dialogfeld  zum Export 
von Amplitude und Phase des akti-
ven Kanals im ASCII-Textformat. 

Export IR as Wave File Zeigt ein Dialog zum Export der 
Impulsantwort als Audiodatei 
(*.Wav).  

File Info Öffnet ein Fenster mit Informatio-
nen zur Messung. 

Print Zeigt den Drucken Dialog an. Es 
wird der aktuelle Anzeigemodus 
ausgedruckt.  

Page Setup Öffnet ein Dialogfeld zum Einrich-
ten der Seite für den Druck.  

Exit Beendet das Programm.  

  

Tools 

Show/Hide Equalizer An-/Ausschalten der Equalizer-
Funktion 

Equalizer Info Anzeige der vorgenommenen 
Equalizer Einstellungen 

Acoustical Parameter Öffnet ein Fenster in dem die aus 
der Messung errechneten akusti-
schen Parameter angezeigt werden.  

Microphone Correction Öffnet ein Fenster über das sich 
Mikrofonkorrektur Kennlinien edi-
tieren, laden und speichern lassen. 

  

Options 

Plot Settings Öffnet ein Fenster über das Einstel-
lungen für den aktuellen Anzeige-
modus vorgenommen werden kön-
nen z.B. FFT-Größe, Fensterfunkti-
on usw. 

CARMA Mode Öffnet ein Fenster zur Einstellung 
des Betriebsmodus. 

Preferences Zeigt das Einstellungen Fenster, 
über das Sie Grundeinstellungen 
von Audionet CARMA bearbeiten 
können. 

  

Help 
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Contents Öffnet das Hilfefenster. 

  
 

8.2 Symbolleiste 
 

 Initialisierung einer neuen Messung 

 Zeigt ein Dialogfeld zum Öffnen 
einer neuen Messung. Als Dateityp 
werden "Audionet Measurement 
Files (*.amf)" erwartet. 

 Speichert eine geöffnete Messung 
unter gleichem Namen als "Audio-
net Measurement Files (*.amf)".  

 Öffnet ein Fenster zur Messvorbe-
reitung und Durchführung. 

 Auswahl des Frequenzbereichs. 
Wahlweise wird der Amplituden-
gang und Equalizer oder der Amp-
litudengang mit akustischer Phase 
angezeigt. 

 Auswahl des Zeitbereichs. Es kann 
zwischen der Impulsantwort h(t), 
logarithmische Funktion des Abso-
lutwertes der Impulsantwort, 
Sprungantwort sigma(t) und der  
Energie-Zeit-Kurve mit Schroeder-
Integral ausgewählt werden. 

 Anzeige des Wasserfalldiagramms. 

 Öffnet das Fenster „Operational 
Window“. Bei dieser Darstellung 
können die einzelnen Kanäle einer 
Messung im Tieftonbereich unter 
Berücksichtigung der Phase sum-
miert werden.  

… Auswahl bzw. Information über 
den aktuell dargestellten Kanal 

 Öffnet ein Fenster über das Einstel-
lungen für den aktuellen Anzeige-
modus vorgenommen werden kön-
nen z.B. FFT-Größe, Fensterfunkti-
on usw. 
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 Aktivierung des Zoom Modus. 

 Zurücksetzen der Zoom-
Einstellungen und Anzeige der Ge-
samtansicht der ausgewählten Dar-
stellung. 

 Ein-/Ausblenden der Equalizer-
Kurve 

 Ein-/Ausblenden der Mikrofon 
Frequenzkennlinie. 

 
 

8.3 Tastenkombinationen 
 
Anzeige/Hauptfenster 

Zoom-Out X Pfeil-nach-links 

Zoom-In X Pfeil-nach-rechts 

Zoom-Out Y Pfeil-nach-unten 

Zoom-In Y Pfeil-nach-oben 

Ansicht nach rechts verschieben Strg + Pfeil-nach-rechts 

Ansicht nach links verschieben Strg + Pfeil-nach-links 

Ansicht nach oben verschieben Strg + Pfeil-nach-oben 

Ansicht nach unten verschieben Strg + Pfeil-nach-unten 

Reset-Zoom Strg + 0 

Popup Fenster schließen & 
Zoom-Modus beenden 

ESC 

  

Record Strg + R 
 
 
 
Filemenu 

New Strg + N 

Open Strg + O 
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Save Strg + S 

Import Eq-Settings Strg + Umschalttaste + E 

Import Overplots Strg + Umschalttaste + T 

Export Eq-Settings Strg + E 

Export Eq-Settings as .txt-File Strg + Q 

Export Overplots Strg + T 

Export Plot as Jpeg Strg + J 

Export IR as Wave File Strg + W 

File Info Strg + L 

Print Strg + P 

Exit Strg + X 

  

Tools 

Show Equalizer Strg + 1 

Equalizer Info Strg + 2 

Acoustical Parameter Strg + 3 

Microphone Correction Strg + 4 

  

Options 

Plot Settings Strg + D 

CARMA Mode Strg + M 

Preferences Strg + F 

  

Help 

Contents F1 
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8.4 CARMA auf Laptops 
Wenn Sie CARMA auf einem Laptop nutzen, sollten Sie die Linearität 
des Mikrofon- bzw. Line-Eingangs überprüfen. Bei vielen Laptops wei-
sen diese Eingänge ein deutliches Hochpassverhalten auf, wodurch bei 
Messergebnissen einen starken Tieftonabfall angezeigt wird. Um dieses 
Verhalten zu kompensieren sind nur wenige Schritte nötig, die im Fol-
genden anhand der externen Signalerzeugung beschrieben werden. 
 
• Deaktivieren Sie zunächst die Mikrofonkorrektur. (Strg+4 bzw.  

Apfel+4  → REMOVE) 
• Verbinden sie den Analogausgang Ihres CD-Players direkt mit dem 

Soundkarteneingang ihres Laptops. 
• Führen Sie nun eine Messung des linken Kanals durch (CARMA 

MODE: LEFT). Dabei sollte die Aussteuerung bis ca. 0dB erreicht 
werden, es darf allerdings nicht zur Übersteuerung (clipping) kommen. 

• Als Ergebnis erhalten Sie den Amplitudengang des Soundkartenein-
gangs in Kombinationen mit dem Amplitudengang Ihres CD-Players. 
Da dieser im Frequenzbereich von 20Hz bis 20 kHz idealisiert als na-
hezu linear betrachtet werden kann, zeigt das erhaltene Messergebnis 
im Wesentlichen den Amplitudengang des Soundkarteneingangs an. 

• Der somit ermittelte Amplitudengang kann nun auf zur bestehenden 
Mirkofonkorrektur aufaddiert werden. Somit wird bei zukünftigen 
Messungen sowohl die Fehlerquelle Mikrofon wie auch Soundkarten-
eingang berücksichtigt. Zu den jeweiligen frequenzabhängigen Korrek-
turwerten für das Messmikrofon wird der entsprechende Amplituden-
wert der Korrektur-Messung aufaddiert. 

 
Beispieltabelle zur Ermittlung der neuen Korrekturwerte 
 

Frequenz 
[Hz] 

Amplitude [dB] 
(Mikrofon) 

Amplitude [dB] 
(Messung) 

Amplitude [dB] 
(Summe) 

20 1.0 -20.5 -19.5 
40 0.5 -12.0 -11.5 
63 0.4 6.9 -6.5 
… … … … 

 
 

 Hinweis 
Die Kontrollmessung kann auch mittels interner Signalerzeugung durch-
geführt werden. Verbinden Sie dazu einfach den Soundkartenausgang mit 
dem Soundkarteneingang und gehen Sie wie oben beschrieben vor. In der 
Regel ist die Linearität des Soundkartenausgangs deutlich besser als die 
des Mikrofoneingangs und kann auch wie externen Messungen mittels 
CD-Player idealisiert als linear angenommen werden. 
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Gemessener Amplitudengang des Laptop Mirkofoneingangs. 

 
Messung des Mikrofoneingangs mit neuer Mirkofonkorrektur. 
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8.5 Fehlerbehebung 
Es erscheint die Fehlermeldung  "Could not find the main class…" 
beim Programmstart 

• Stellen Sie sicher das sich das Unterverzeichnis "/bin" im gleichen 
Ordner befindet aus dem Sie die Datei CARMA.exe (CARMA.jar bei 
OS X) starten. 

 
 
Das über die Soundkarte ausgegebene Messsignal klingt verzerrt. 

• Stellen Sie sicher, dass Ihre Vorstufe richtig an den Computer ange-
schlossen ist. 

• Sollte Ihr Soundkartentreiber die Auswahlmöglichkeit einer festen 
Abtastrate bieten, stellen Sie diese auf 48,0 kHz bzw. 44,1 kHz (Je 
nach Auswahl unter Preferences) und benutzen Sie eine Bittiefe von  
16 Bit.  

• Vergewissern Sie sich beim Betrieb unter Windows Vista das die Ein-
gestellte Abtastrate in CARMA mit der Einstellung in ihrer Sys-
temsteuerung übereinstimmt und eine Bittiefe von 16 Bit zur Audio-
ausgabe verwendet wird. 

 
 
 
Pegelanzeige im Aufnahmefenster zeigt kein Eingangssignal an 

• Überprüfen Sie Ihre Verkabelung 
• Stellen Sie sicher dass Sie den richtigen Eingang des Systemmixers 

ausgewählt haben (Line-In/Mic-In) und die Eingangsempfindlichkeit 
richtig eingestellt ist. 

• Da es sich um eine Mono Aufnahme handelt wird standardmäßig der 
linke Kanal verwendet. Unter dem Menüpunkt Tools > Preferences  
kann wahlweise zwischen dem linken- und rechten Kanal ausgewählt 
werden. 

 
 
Nach der Auswahl von Soundkarten Ein-/Ausgang in der Systemsteue-
rung funktioniert die Aufnahme/Wiedergabe nicht. 

• Stellen Sie sicher dass Sie den richtigen Ein-/Ausgang bei Ihrem Sys-
temmixer eingestellt haben. 

• Bei Änderung der Soundkarten Einstellungen in der Systemsteuerung 
ist es bei manchen Betriebssystemen nötig CARMA neu zu starten. 
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Bei Mehrkanalmessung (7.1) wird das Messsignal nicht korrekt über 
die Surround-Lautsprecher wiedergegeben. 

• Überprüfen Sie den Betriebsmodus des Dolby Decoder Ihrer A/V Vor-
stufe. Bei einer 7.1 Messung muss der Movie-Modus verwendet wer-
den. 

 
 
Bei Mehrkanalmessung mit interner Signalerzeugung kommt nur Rau-
schen aus den Lautsprechern 
Die Ausgabe von DTS und Dolby Digital Signalen mittels Digitalaus-
gang der Soundkarte setzt voraus, dass das Audiosignal unverändert aus-
gegeben wird. Diese Funktion unterstützen in der Regel nur professionel-
le Studiosoundkarten oder Soundkarten neuer Generation. 
 
• Verwenden Sie für die Signalausgabe den Digitalausgang Ihrer Sound-

karte 
• Überprüfen Sie ob Ihre Soundkarte eine unveränderte Digitalausgabe 

unterstützt. Informationen darüber finden Sie in der Regel in der Be-
dienungsanleitung des Drittanbieters.  

• Stellen Sie sicher, dass der Ausgangspegels des Digitalausgangs auf 
Maximum (Soundkartenmixer) steht und somit das Signal unverändert 
ausgegeben werden kann. 

• Versuchen Sie die Signalausgabe mit einer anderen Abtastrate (44,1 
kHz oder 48 kHz) 

• Sollte Ihr Soundkartentreiber die Auswahlmöglichkeit einer festen 
Abtastrate bieten, stellen Sie diese auf 48,0 kHz bzw. 44,1 kHz (Je 
nach Auswahl unter Preferences) und benutzen Sie eine Bittiefe von  
16 Bit.  

 
 
Bei den Messergebnissen werden nicht alle angeschlossenen Kanäle 
angezeigt es erscheint die Fehlermeldung "The following channels 
were not detected: … ". 

• Falls Sie die externe Signalerzeugung nutzen, stellen Sie bitte sicher 
dass Sie die richtigen Titel der Messsignal CD verwenden 

Track 1 – Track 7   : Signale für externe Messungen mit 48,0KHz 
Track 8 – Track 14 : Signale für externe Messungen mit 44,1KHz 

• Führen Sie Ihre Messungen bei einer höheren Lautstärke durch, um 
den Signal-Rauschabstand zu erhöhen. (Kapitel 5.4: Kalibrierung/ Pe-
geleinstellungen) 

• Vergewissern Sie sich beim Betrieb unter Windows Vista das die Ein-
gestellte Abtastrate in CARMA mit der Einstellung in ihrer Sys-
temsteuerung übereinstimmt und eine Bittiefe von 16 Bit zur Audio-
ausgabe verwendet wird. 
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Der gemessene Amplitudengang scheint nicht korrekt. (Hochtonbe-
reich fehlt, Messung weist kein Hochpassverhalten auf) 
Bei zu geringer Messlautstärke kann es vorkommen, dass der Anfang der 
Impulsantwort nicht korrekt erkannt wird.  

 
   
• Verschieben Sie die Impulsantwort über das Menü Processing > Move 

Impulse Response einige Samples (ca. 100). Wiederholen Sie diesen 
Vorgang solange bis eine deutliche Flanke zu erkennen ist.  

• Tritt der Fehler mit Ihrer Soundkarte ständig auf, können Sie unter 
Options > Preferences den Wert von Samples before detected IR start  
von 20 Samples auf einen höheren Wert stellen. 

 
 
Der gemessene Amplitudengang sieht "verzackt" aus. 

• Erhöhen Sie den Wert der Glättungsfunktion (Octave-Band 
Smoothing). 

• Stellen Sie bei interner Signalerzeugung sicher, dass keine Rückkopp-
lungseffekte auftreten, deaktivieren Sie die Monitoring Funktion des 
Soundkarteneingangs. 

 
 
Bei der Amplitudengang Darstellung wird der Bassbereich ungenau 
oder zu gering angezeigt. 

• Überprüfen Sie die Linearität des verwendeten Soundkarteneingangs 
(Kapitel 8.4: CARMA auf Laptops)  

• Erhöhen Sie die Anzahl der Punkte der Fourier-Transformation (FFT 
Size)  

• Verringern Sie den Wert der Glättungsfunktion (Octave-Band 
Smoothing). 

• Setzen Sie ggf. das Zeitfenster zurück (Reset Selection (start:0 – end: 
FFT Size)) 
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8.6 Glossar 
 
Fast Fourier Transfor-
mation 

Die Grundidee der Fourier Transformation 
ist ein beliebiges Signal als die Summe einer 
Folge von sinusförmigen Signalen mit unter-
schiedliche Amplituden und Phasen anzunä-
hern. Jedes Sinussignal repräsentiert ein ein-
zelnes Frequenzband, wobei sich aus der 
Summe aller das Frequenzspektrum des ge-
messenen Signals bilden lässt.  
Dadurch wird  eine  Darstellung im Zeitbe-
reich (Zeitpunkt, Abtastwert) in die Darstel-
lung (Frequenzanteil, Amplitude, Phase) 
überführt. 
Um den enormen Rechenaufwand zu redu-
zieren wurde ein spezieller Algorithmus ent-
wickelt der sich Fast Fourier Transformation 
(FFT) nennt.   

FFT Size (FFT Größe) Anzahl der Daten-/Abtastpunkte die für die 
Fourier Transformation verwendet werden. 
Durch die logarithmische Darstellung des 
Amplitudengangs verbessert ein größerer 
Wert vor allem die Auflösung im Bassbe-
reich. 

Impulse Response 
(Impulsantwort) 

Die Impulsantwort eines Systems beschreibt 
vollständig die linearen Eigenschaften eines 
Systems, sowohl im Zeitbereich als auch 
durch eine Transformation im Frequenzbe-
reich. 

Sampling Rate 
(Abtastrate) 

Die Häufigkeit, mit der ein Signal pro Zeitin-
tervall abgetastet wird. Arbeitet ein A/D 
Wandler mit einer Rate von 48kHz entstehen 
somit 48000 Abtastpunkte pro Sekunde.  

Step Response 
(Sprungantwort) 

Die Sprungantwort ergibt sich aus der ma-
thematischen  Integration der Impulsantwort. 
Sie beschreibt das Verhalten des Systems bei 
Anregung mit einem Einheitssprung (Heavi-
side-Funktion). 

Octave-Band 
Smoothing 

Glättung des Kurvenverlaufs über 1/n-
Oktaven.  
Die 1/3 Oktav Glättung ist die für akustische 
Messungen mit am besten geeignet. 

Waterfall Plot Bei dieser dreidimensionalen Darstellung, 
wird in horizontaler Richtung (x-Achse) die 
Frequenz und in vertikaler Richtung (z-
Achse) den Pegel (Amplitude) der Spektral-
ausschnitts aufgetragen. Die Zeit t wird in 
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tausendstel Sekunden (ms) auf der Achse 
abgebildet, welche von hinten auf den Bet-
rachter zu läuft (y-Achse). 

Window Funktion 
(Fensterfunktion) 

Fensterfunktionen verhindern so genannte 
Leckeffekte im Frequenzbereich, die durch 
die Fourier Transformation von "abgeschnit-
tenen" nichtperiodischen Signalen entsteht. 
Durch die Multiplikation der Zeitdaten mit 
einer bestimmten Funktion, gehen die Werte 
an den Enden des betrachteten Zeitabschnit-
tes gegen Null. 
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